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SPECIAL PREVIEW!

Welcome to Indiana Jones' latest exploits in a new kind of game from LucasArts! This SPECIAL 
PREVIEW will let you play and replay a single game (out of billions of possibilities) to find out what 
desktop adventuring is all about.    Depending on the level of difficulty you choose, you can probably finish
the whole thing in thirty minutes or less!

We enjoyed creating this unique story game system, and we hope you enjoy playing it.    If you did, and 
would like to renew the experience without repeating it, head for your nearest computer entertainment 
retailer or call our direct sales force - the full version, with billions of variations, will be on sale starting in 
the last week of April, 1996...



THE STORY

It's the mid-1930's, and Indiana Jones, Ph.D., excited by the fantastic finds emerging from the 
deserts and jungles of Middle America, travels south of the border to make his mark on archeology.    The 
stated purpose of his expedition is to survey a temple complex known as Site R, but no sooner have Indy 
and his colleague, Marcus Brody, set up headquarters in the little town of Lucasio than they realize more 
important issues are at stake. Everywhere they turn, thieves and scavengers, many calling themselves 
scientists, are ransacking historical sites and selling off their priceless treasures to the highest bidder...

Soon Indy is embroiled in a dangerous contest, rushing to find a series of dazzling artifacts and 
get them into safe hands before his unscrupulous rivals, led by the shady collector Dr. Victor Van Loon 
and a crackpot Nazi general, Anton Schlossberg, can steal them.

As the player, you are Indiana Jones. At the start of each game, you should consult with Marcus 
on the latest emergency.    He'll supply the first item you need to get going.    From there it's up to you to 
explore, trade, and fight your way through dangerous terrain to resolve the crisis at hand.

In your adventures you will encounter fierce warriors and deadly banditos, poisonous spiders and 
vicious jaguars...and maybe even a snake or two.    And before you're done, you will confront the uncanny
forces of the Ancient Gods, including the mighty feathered serpent, Quetzalcoatl.    (Why'd it have to be a 
snake?)
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Quick Tips

    Sitting near the fountain in Lucasio, you'll find Bonifacio.    He can be a great help if you're having 
trouble with basic elements of game play.    Each time you talk to him he will give you a different tip.    
Listen to what he has to say - he's very wise.



Walking Around 
To move Indy around the Desktop Adventures world, press and hold your left mouse button.    Indy will 
walk in the direction of the arrow showing on your pointer.    As you hold down the button and move the 
pointer around the window, Indy will follow.

To activate floor switches, just walk on top of them.    To activate wall-switches and to open unlocked 
doors, simply bump into them.    To walk into a house, hut, cave, etc., move Indy into the opening, and he 
will enter.    To walk into adjacent areas of the game world, move Indy to the edge of the display window 
and keep walking.    Indy will cross into the next area if there is one.

(TIP:    Sometimes Indy can't cross into a new area, even when one exists.    That probably means some 
unseen obstacle at the destination is in the way.    Move along the border and try again.)



Talking to People
To talk to characters in the game, simply move Indy until he bumps into them.    If a character has 
something to say, a dialogue balloon will appear.    Scroll the text by clicking on the up & down arrows.  
When you have read everything, click on the dot to close the balloon. 

(TIP:    Pressing ESC or ENTER will end the dialogue at any time, but be careful:    you may not get 
another chance to read the same information.)



Pushing and Pulling Things
You never know where you'll find some of the items Indy needs to complete his quest.    Sometimes 
they're buried under rubble or hidden under boxes.    Sometimes Indy just needs to get past a stone block 
that's in his way.    To push or pull an object, walk Indy next to it, hold down either SHIFT key, then walk 
toward or away from the object.    If the object can move, it will.    You'll just have to figure out what Indy is 
strong enough to muscle around.



Picking Up and Using Items
Indy's world is full of useful things.    To pick up an item (such as the whip in Indy's room), simply bump 
into it as you would a character.    The item will start to flash, and your pointer will turn into a hand.    Left-
click on the item, and it will pop into your inventory.

The items you collect can be used to open doors, to activate vehicles, to trade for other items, and so on.  
To use an item, locate its icon in your inventory and left-click on it.    Your pointer will become that item.    
Then move your pointer to the spot where you wish to use the item and left-click again.    If you're using 
the correct item in the correct location, something will happen.    Remember:    actions don't work at a 
distance.    You must stand as close as possible to the location where you want to use an item to get 
results.

For example:    suppose you have a key in your inventory, and you stumble across a locked chest.    To 
unlock the chest, first stand close beside it, then pick up the key by left-clicking on its inventory icon.    
Now place it over the chest and left-click again.    If the key fits, the chest will open.    If not, maybe there's 
another key to be found, or even a different way to open the chest.



Readying and Wielding Weapons

    Indy's in a hostile environment, and he needs to defend himself.    His whip is always available - 
look for it in Lucasio.    In each game you can also find another, more powerful weapon.    To ready a 
weapon for action, left-click on its icon in your inventory.    Then either left-click on Indy or the Ready 
Weapon Box between the Compass and Health Monitor.    To wield a weapon, aim Indy in the direction 
you wish to attack, and right-click your mouse or press the spacebar.    Be careful;    some enemies can 
strike from any direction, but Indy can only attack vertically and horizontally.

(TIP:    The whip is the weakest weapon in the game, but it's also the only weapon that works over 
obstacles!)



The Compass

    The arrow cluster to the left of the Ready Weapon Box is Indy's Compass.    Indy can travel in 
the direction of green arrows to reach unseen but nearby areas of the game world.    If an arrow is 
dimmed, then there is no connecting terrain in that direction.

(TIP:    Sometimes Indy can't enter a different area even when the correct arrow is green.    That probably 
means some unseen obstacle at the destination is in the way.    Move along the border and try again.)



Health

    As Indy battles through the game, the creatures and enemies he encounters will inflict damage, 
and his Health Monitor will gradually turn from green to yellow to red and finally to black.    Green 
means Indy is in good shape, yellow signals caution, and red means Indy's health is dangerously low.    
Watch out:    when the monitor is fully black, the game is over!    But don't worry, sometimes you can find 
medicinal herbs and other remedies to heal Indy.    If all else fails, José, the grocer in Lucasio, will help 
you.    To restore Indy's health, left-click on the remedy icon in your inventory, then left-click on Indy.

(TIP:    If your health declines too quickly for comfort, select Combat Difficulty from the Options menu 
and adjust the slider to an easier setting.)



Indy Quotient

    Each time you win a game, no matter how ragged you feel at the end, it's an 
achievement, so congratulations!    In case you're interested in more detail, your score is posted in the 
victory display.    This is Indy's IQ, and it depends on three factors:    how quickly you finished, how many 
puzzles you had to solve to reach the end, and how difficult it was to defeat your adversaries.  Fast play 
yields higher scores than slow play.    Large worlds yield higher scores than small worlds.    Hard combat 
yields higher scores than easy.    To give you something to shoot for, the maximum possible IQ is 1,000.    
Reaching the top is like ringing the gong at a carnival - you can do it, but it's harder than it looks.    So 
here's a tip of Indy's famous fedora to anyone who succeeds in achieving perfection!



THE MAP
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Looking at the Map

    One of the most important things to find at the beginning of each game is the Map.    It's always 
hidden somewhere near Lucasio.    Examine it by clicking on the map icon in your inventory or by pressing
M.    The map shows you the entire world Indy is exploring, with his current position marked by a blinking 
red X.  To return to the game, left-click anywhere that doesn't show a special map symbol, or press M 
again, or right-click anywhere at all.    By using the map, you can keep track of your progress as well as 
plan your next move.



Map Symbols
As you travel through the game world, the areas you visit will brighten.    When you arrive in special 
areas, the map will mark them with special symbols.    Below are the symbols you'll see and what they 
represent:

    Lucasio - this is Indy's home base.    You'll start every game here.    Be sure to talk to everyone you
encounter.    Bonifacio is lounging near the fountain;    ask him for quick tips on basic game play.    Indy's 
expeditionary headquarters is in the house north of the fountain;    there Marcus will get you started on 
each mission.    José has a small store nearby;    when you get in trouble, he'll restore your health.    In the 
cantina you'll find Gabriela;    sometimes she'll dispense tequila, sometimes a bunch of health-enhancing 
bananas, and sometimes just a sharp word of advice.    And don't forget your whip!    It's in the little stucco 
house south of the fountain.

    Puzzles - you will have to solve several puzzles to finish each game.    Their locations are 
marked by jigsaw puzzle piece symbols.    Until a puzzle is solved, the symbol is outlined.    Once a 
solution is found, the symbol is highlighted. 

    Blockades - a blockade is a puzzle that bars your way to some areas of the game world until 
you find a solution.    Each blockade shows on the map as a solid wall until you breach it;    after that an 
opening appears.

    Gateways - you'll often see areas on the map that are isolated from the rest of the world.    You 
can't reach them by hiking, but for each one there's a special connection.    It can be a tunnel, a boat, or 
even a blimp!    You must solve a puzzle to activate each gateway.    Until you do, its symbol is outlined.    
Once a gateway becomes usable, the symbol is highlighted.

    Teleport Stations - scattered about the map are mystical devices that enable Indy to jump 
quickly from area to area.    Look for stone platforms with strange glyphs carved in them.    Some of these 
stations are active the first time you see them, others must be activated by solving puzzles.    Once Indy 
has the map in his possession, whenever he steps on a glyph the map will automatically appear with all 
active destinations visible and highlighted.    Just left-click on the symbol for any station, and you're 
there!    If you're lucky, stations will be well-placed to teleport you from one end of the world to the other.    
Sometimes they're not quite where you'd like them to be.    On smaller worlds, there may not be any 
stations at all.

    The Final Chapter - this symbol represents the area where the final showdown, whatever that may
be, will take place.    You may come across it before you actually have what you need to win, so make 
sure you're ready when you decide to try for the final prize.



Map Clues
One of the handiest features of the map is its clue system.    Once you've discovered an area, go to the 
map.    Left-click on any of the special map symbols.    A hint balloon will appear, telling you what you 
need to solve that particular puzzle.



MENU COMMANDS
File
Options
Window
Help



File
New World - builds a new world with a new story.    This command discards the current world.

Replay Story - builds a new world but keeps the current ending.    Useful if you lose a game and want to 
try the same story again.    This command discards the current world. 

Load World - loads a previously saved world.    This command discards the current world.

Save World - saves the current world.    Type in the file name and choose a folder to save into.    The 
default folder is the directory where Indy's Desktop Adventures is stored.

Exit - closes and exits the game.



Options
Combat Difficulty - adjusts the effects of combat.    Easier settings weaken Indy's opponents.    Harder 
settings strengthen them.    The game defaults to MEDIUM.

Game Speed - adjusts how fast Indy and other characters move.    On higher settings, action is faster, but
may be harder to control.    The game defaults to NORMAL.

World Control - adjusts world size.    Smaller worlds tend to be less complex, but quicker to finish.    You 
must build a new world for a new setting to take effect.    The game defaults to MEDIUM.

Sound On - toggles sound effects on and off.    The game defaults to ON.

Music On - toggles music on and off.    The game defaults to ON.

Pause - pauses and unpauses the game.



Window
Hide Me! - this option quickly minimizes Indy's Desktop Adventures.    Handy when you hear your boss 
approaching.



Help
How To Play - launches this guide.

Using Help - brings up general directions on how to use Help files.

About - shows information about Indy's Desktop Adventures.



HOT KEYS

Game Play
Walk - ARROW keys or NUMERIC KEYPAD with Num Lock OFF

Diagonal Walk - HOME, PAGE UP, END, PAGE DOWN

Push or Pull Item - SHIFT key

Pick Up Flashing Item - SPACEBAR or INSERT key with Num Lock OFF

Attack - SPACEBAR or INSERT key with Num Lock OFF

Toggle Map Display - M key

Toggle Pause - P key

Dialogue Balloons
Scroll Up and Down - Up & Down ARROW keys

End Dialogue - ESC key or ENTER key
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Installing in Windows 3.1x
Insert the game diskette into the appropriate floppy drive.    Open the File menu located at the top left-
hand corner of the Windows Program Manager and select Run.    In the Command Line edit box, type in
the letter of the drive where you inserted the Desktop Adventures disk followed by ":\setup".    (Example:   
a:\setup.)    Select OK.    This will start the SETUP program for Indy's Desktop Adventures.



Installing in Windows 95
Insert the game diskette into the appropriate floppy drive, then click on the Start button located at the left 
end of the Taskbar.    Select Run, then in the Open edit box, type in the the letter of the drive where you 
inserted the Desktop Adventures disk followed by ":\setup".    (Example: a:\setup.)    Select OK.    This will 
start the SETUP program for Indy's Desktop Adventures.



Uninstalling
If you wish to remove Indy's Desktop Adventures from your system for any reason, do the following:

Windows 3.1x

Open File Manager, locate the folder where you installed the game, select Delete... from the File menu, 
type in the folder name, and click on OK.  Next, move to your Windows directory and delete the file 
DESKADV.INI using the same procedure.    Finally, move to the Program Group representing the game 
and delete the appropriate icons.

Windows 95

Go to Start, select Programs, and then Windows Explorer.    Locate the folder where you installed the 
game and drag it to your Recycle Bin.    Next, open your Windows folder and delete the file 
DESKADV.INI using the same procedure.    Finally, go to Start, select Settings, then Taskbar... and 
follow onscreen instructions to remove the appropriate icons from the Start menu.

Saved Worlds

The worlds you save while playing Indy's Desktop Adventures can reside on any writable storage device.  
If they're in the folder or directory where you installed the game, deleting the folder will delete them as 
well.    Otherwise, please track them down separately wherever you saved them.    Saved world files 
usually have a .wld extension.

(TIP:    Don't be afraid to delete unwanted saved worlds at any time.    Doing so will have no adverse effect
on the operation of Indy's Desktop Adventures.)
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Questions & Answers

Q>    I'm running Windows 95, and when the SETUP program ends I get an error message telling me that 
it could not create a program group and icon.    What does this mean?

A>    The SETUP program had trouble talking to the Windows Program Manager.    Please restart 
Windows, then run SETUP again.    This should solve the problem. 

Q>    I received a message stating "the game won't run in 16 Color Mode."    What is a color mode, and 
how do I change it?

A>    A color mode is simply the number of colors your computer is configured to display.    16 Color Mode 
means Windows is set to display a total of 16 colors.    Indy's Desktop Adventures requires your machine 
to display a minimum of 256 colors in order to run.    To solve the problem, exit from the game, change the
color mode, then restart your computer.    For detailed instructions on how to set the color mode, please 
consult your Windows documentation or your video card manual.

Q>    Why does Indy move around so slowly?

A>    First, you may have the Game Speed adjusted too low.    Open the "Options" menu, select "Game 
Speed," and choose a faster setting.    If the problem persists with Game Speed at its fastest setting, you 
may have a slower video card, or possibly one that does not perform well with the color mode or screen 
resolution you've selected.    Try changing screen resolution and/or color mode.

Q>    Why does my mouse pointer flicker?

A>    Generally, this is due to a slower video card.    However, there are a small number of fast cards on 
the market whose software is not fully optimized for Windows.    Try changing resolution and/or color 
mode.

Q>    Why does it take several minutes for Indy's Desktop Adventures to load the first time I start it up, or 
when building new worlds?

A>    This problem can occur if you are using a slower machine, or if you are low on memory (RAM), 
especially if you are running in Windows 3.1x.

Q>    Why does Indy's Desktop Adventures take so long to load on my otherwise speedy laptop computer?

A>    Laptops often run software in the background to monitor the battery and manage power usage.    
Most such programs are benign, but a few can cause noticeable slowdowns in other applications.    If you 
experience very long load times or sluggish performance on a fast machine, temporarily turn off all power 
management software, then restart the game.

Q>    Why doesn't Indy respond to the mouse and keyboard controls?

A>    Chances are the game is paused.    Try pressing the "p" key or, from the "Options"    menu,    uncheck
"Pause." 

Q>    Why do I sometimes see strange colors in Indy's Desktop Adventures?



A>    This sometimes happens when another application is competing for vital system resources or is 
cycling the Windows color palette.    Try minimizing, then maximizing the game.    If that doesn't work, try 
closing any other applications, then resume play.    As a last resort, you may have to save your world, exit 
from Indy's Desktop Adventures, and then restart the game without other applications running.

Q>    Why do I sometimes have trouble closing dialogue balloons using keyboard controls?

A>    This can happen if your mouse pointer has drifted off the game window.    For full keyboard control of 
dialogue balloons, please move your mouse pointer somewhere within the Desktop Adventures window.

Q>    I'm running Windows 3.1x.    Why do I see the message, "failed to launch help" when I try to open the
Help Guide?

A>    In Windows 3.1x, some system software configurations use up more "conventional DOS memory" 
than others, and your computer may become confused about the amount of memory that is really 
available.    If you see this message, and you need help while you play, try starting the Desktop 
Adventures Help Guide directly from the Program Manager, and then launch Indy's Desktop Adventures 
afterwards.

Q>    Why is it that certain applications perform poorly while running with Indy's Desktop Adventures?

A>    Chances are you are low on memory.    You may have to save your world, then exit from Desktop 
Adventures before running other memory-hungry programs.

Q>    I got an error message saying something about WinG and my video display driver.    What in the 
heck is WinG?!

A>    Indy's Desktop Adventures uses a Microsoft system extension called WinG to optimize graphics 
performance under Windows 3.1x.    Microsoft has acknowledged that WinG has a few hiccups!    The 
WinG error message is telling you that your video card is using drivers that are out of date.    You can 
continue to play, but the game will run more slowly than it should.    To solve the problem, contact your 
video card manufacturer for the most recent drivers, and install them. 

Q>    Why do I have trouble starting Desktop Adventures while my screen saver is running in the 
background?

A>    Some after-market screen savers monopolize system resources when they wake up and take over 
your computer.    Please be sure your screen saver wake-up interval is longer than the loading time of 
Indy's Desktop Adventures, then restart the game.    If your screen saver is Star Wars Screen 
Entertainment, you can eliminate the problem by selecting GDI graphics in the SWSE SETUP program.

Q>    Why do I get an "In Control Tools" pop-up menu when I right-click the mouse? 

A>    You are running a Diamond Multimedia utility called "In Control Tools."    In order to free the right 
mouse button for Indy's Desktop Adventures, you must disable "In Control Tools." 



Windows 3.1x Users
Memory

In Windows 3.1x, applications share the computer's valuable resources, including memory (RAM).    In 
particular, each running application uses up a fraction of precious "conventional DOS memory," and no 
matter how much total memory you have, this limits the number of programs you can run.    Moreover, 
WinG, the Microsoft graphics accelerator used by Desktop Adventures, also needs conventional memory, 
as do sound and video card drivers, power managers, and so forth.    If too many programs compete, low 
memory situations can arise.

Some common symptoms of low memory are: "failed to launch help" error message;    inability to start 
other programs while Desktop Adventures is running;    excessive load time while starting a new game. 

If you have difficulty running Indy's Desktop Adventures or the Desktop Adventures Help Guide, try 
closing any applications that are not currently being used.    This will free up extra memory.

Network drivers are among the greatest memory consumers.    If possible, restart Windows without 
loading network software.    (In Windows 3.11, you can accomplish this by restarting with the command, 
"win /n".)

In order to achieve optimal performance while running Indy's Desktop Adventures, make sure VIRTUAL 
MEMORY is turned ON, with the Virtual Memory SWAP FILE set to equal or exceed the amount of RAM 
in your machine (at least 8 megabytes).    For more information on configuring Virtual Memory and Virtual 
Memory Swap Files, please see your Windows 3.1x documentation.

Music

Windows 3.1x expects to see music (MIDI) files in several different, mutually exclusive formats.    For 
playability on the widest variety of sound cards, the music files used by Indy's Desktop Adventures 
contain all formats.    Thus, you may encounter a spurious message stating, "MIDI may not play correctly." 
Please check the box entitled "Don't show this message again" to prevent further notification, and enjoy 
the game.



Hardware Problems
The LucasArts Quality Assurance group has found a few problems with certain hardware configurations.    
Below is a list of problematic devices and their symptoms.    In most cases these problems can be rectified
by contacting the device manufacturer and obtaining the latest drivers.

Video Cards: 

ATI DESKTOP Software
Many ATI video cards use a utility for Windows 3.1x called "ATI Desktop."    This software corrupts the 
color palette in 256 Color Mode when "WinSwitch" is active.    Turning "WinSwitch" off solves the problem.

ATI GRAPHICS EXPRESSION
ATI GRAPHICS PRO TURBO
(MACH 64)
Windows 3.1x users may see unpleasant screen flashing when their computer is set to display thousands 
or millions of colors.    Upgrading to driver version 2.01 solves the problem.    (If you see missing letters in 
text displays with this driver, drop back to 256 Color Mode.)    

DIAMOND STEALTH 64 VIDEO VRAM
DIAMOND STEALTH 64 3000 Series
Sluggish game performance running in Windows 3.1x in 256 Color Mode.    Try changing color mode.

DIAMOND STEALTH SE PCI
Cursor appears in the wrong position when running Windows 95 with the driver supplied by Windows 95 
in High Color (16 bit) Mode only.    Try changing color mode.

ORCHID VLB KELVIN 64
Excessive cursor blinking running Windows 3.1x in video mode that displays millions of colors (sometimes
called True Color (24 bit) Mode).    Changing to thousands of colors (High Color (16 bit) Mode) or 256 
Color Mode solves the problem.

STB SPRINT 32 PCI
General protection fault in Windows 3.1x while displaying millions of colors (True Color (24 bit) Mode).    
Changing to thousands of colors (High Color (16 bit) Mode), or 256 Color Mode solves the problem.

NUMBER NINE #9GXE 
When characters talk, you may see ugly-looking dialogue balloons.    Open the Number Nine Control 
Panel, then the "Place Window" utility.    In the box labeled "messages in" choose VIRTUAL instead of 
MONITOR to solve the problem.

Sound Cards

ENSONIQ SOUNDSCAPE S-2000
Early drivers may lock up with a General Protection Fault, especially in Windows 3.1x.    Upgrading drivers
to version #1.30.03 solves the problem.

CREATIVE LABS SOUND BLASTER 16
SOUND BLASTER 32
SOUND BLASTER AWE32



Sounds cut out running in Windows 95.    Upgrading drivers to version #4.13.xx solves the problem.

MEDIA VISION PRO AUDIO SPECTRUM
PRO AUDIO STUDIO
In Windows 3.1x, sounds may cut out or repeat.    De-activating the game (with a click on the desktop, for 
example), and then re-activating it solves the problem.

MEDIA VISION PRO AUDIO DELUXE
PROSONIC
JAZZ-16
In Windows 95, digital sound effects may not play smoothly.    To solve the problem, open the Windows 
directory with Windows Explorer and rename the file WAVEMIX.INI (to something like WAVEMIX.BAK, for 
example).



CONTACTING LUCASARTS
Any Questions?

Call our Technical Support line at: 415-507-4545. 

When you call, please be sitting in front of your computer with paper and pen, and gather as much 
pertinent information about your computer as you can assemble: make, model, amount of RAM and hard 
disk size, graphics card type, make and model of sound card and CD drive, and information about your 
version of Windows.

You can also write to Technical Support at:

LucasArts Entertainment Company
Attention: Product Support
P.O. Box 10307
San Rafael    CA    94912

Product Support hours are 8:30 am to 6:00 pm Pacific Standard Time, Monday through Thursday; and 
8:30 am to 5:00 pm Pacific Standard Time, Friday.

Technical Support FAX:    415-507-0300

LucasArts File Library:    415-507-0400    (available 24 hours a day for file download ONLY.    NOT a 
message base.)

Where To Find Us Online:

CompuServe: Game Publisher's Forum A (Go GAMAPUB)

America Online: Keyword "Lucas"

Internet E-Mail: Send mail to 75300.454@compuserve.com OR lucasarts3@aol.com

Home Page: http://www.lucasarts.com

Need More Hints?

Please DO NOT call Technical Product Support for HINTS.    Technical representatives do not give hints 
over the phone.    However, you may call our 24-hour automated hint line at:

1-900-740-JEDI    (1-900-740-5334)

This service costs 75 cents a minute, and you must be over 18 years old or have your parents' permission
to call.

Would You Like To Order Directly From LucasArts?

You can order Games and Strategy Guides directly from LucasArts either by telephone or mail order:

1-800-98-LUCAS in the United States or FAX:    818-587-6629 

LucasArts Company Store
P.O. Box 9367



Canoga Park    CA    91309-0367



WARRANTY INFORMATION

Limited Warranty

Notice: LucasArts Entertainment Company (LEC) reserves the right to make changes in the special 
preview described in this manual at any time and without notice.    The preview software product and this 
manual are copyrighted and all rights are reserved by LEC.

THE ENCLOSED SOFTWARE, MEDIA AND DOCUMENTATION ARE PROVIDED "AS IS".

LEC MAKES NO WARRANTIES WHATSOEVER REGARDING THE ENCLOSED PREVIEW SOFTWARE, MEDIA AND PREVIEW 

DOCUMENTATION, WHETHER WRITTEN OR ORAL, EXPRESSED OR IMPLIED, INCLUDING, WITHOUT LIMITING THE 

GENERALITY OF THE FOREGOING, WARRANTIES AND CONDITIONS OF MERCHANTABILITY OR FITNESS FOR A 

PARTICULAR PURPOSE, EVEN IF LEC HAS BEEN INFORMED OF SUCH A PURPOSE.    ACCORDINGLY, THE ENTIRE RISK 

AS TO THE USE, RESULTS AND PERFORMANCE OF THE SOFTWARE, MEDIA AND DOCUMENTATION IS ASSUMED BY 

YOU.    IN NO EVENT WILL LEC BE LIABLE TO YOU OR ANYONE ELSE FOR ANY CONSEQUENTIAL, SPECIAL, OR INDIRECT 

DAMAGES RESULTING FROM POSSESSION, USE, OR MALFUNCTION OF THIS PREVIEW, INCLUDING WITHOUT 

LIMITATION, DAMAGE TO PROPERTY AND, TO THE EXTENT PERMITTED BY LAW, DAMAGES FOR PERSONAL INJURY, 

EVEN IF LEC HAS BEEN ADVISED OF THE POSSIBILITY OF ANY SUCH DAMAGES OR LOSS.    SOME STATES DO NOT 

ALLOW LIMITATIONS ON THE DURATION OF IMPLIED WARRANTIES AND/OR THE EXCLUSION OR LIMITATION OF 

INCIDENTAL OR CONSEQUENTIAL DAMAGES, AND THUS THE PRECEDING LIMITATION AND/OR EXCLUSIONS AND 

LIMITATIONS MAY NOT APPLY TO YOU. THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY HAVE 

OTHER RIGHTS DEPENDING ON THE LAWS IN YOUR STATE. YOU AGREE THAT THE LIABILITY OF LEC ARISING OUT OF 

ANY KIND OF LEGAL CLAIM (WHETHER IN CONTRACT, TORT, OR OTHERWISE) WILL NOT EXCEED THE AMOUNT YOU 

ORIGINALLY PAID FOR THE USE OF THIS PREVIEW PRODUCT.

LucasArts Entertainment Company
P.O. Box 10307
San Rafael    CA    94912




